Geography Notes : PPA2 Revision
Climate, Vegetation and Deforestation
1) Climate:

With respects to reading a climograph, be able to tell what climatic region the graph represents,
and be able to describe what you see on the graph. Make sure to use proper geographical
terms, key terms.

a) Equatorial
b) Tropical monsoon
c) Cool temperate

Point- what you see on the graph

Descriptor word/Adverb

Reading from graph(stats)

Please refer to AS1 climate for all of the descriptors.

For example, temperature

P - High annual temperature
D/A - High

R - 25.1 degrees Celsius

2) Vegetation: Characteristics and Adaptations

Make sure to use proper geographical terms for describing/ explain the characteristics and
adaptations.

a) Equatorial
b) Coniferous

c) Mangroves

Refer to the following handout

Know the skill PEEL and PPECS to answer this type of question.

3) Deforestation: Causes and Effects (+ve + -ve) (solutions good to know)
Know the skill PEEL and PPECS to answer this type of question.

Refer to HD1 Deforestation for the causes and effects.



https://drive.google.com/file/d/0B-aNa5DoYMWkdDNXb0tEYnZ4SWc/view?usp=sharing
https://drive.google.com/file/d/0BwS-KjjXJmiyYUsyaFNHZVdMZFU/view?usp=sharing
https://drive.google.com/a/rafflesgirlssch.edu.sg/file/d/0B-aNa5DoYMWkR2lEOVd1Y2dlOHM/view?usp=sharing

Climates:

Recap from Year 1

definition of weather: specific atmospheric conditions in a short period (e.g. day/night)
definition of climate: average conditions over a long period of time (usually >30 years)

When describing the climate shown in a climograph, use the following terms: [adhere to this
strictly]

a)

Altitude
> is not affected when below 500 m
> every 1000 m increase will result in a rough decrease of 6.5°C

Influence of Climate on Vegetation Growth
Different types of natural vegetation are found in different parts of the world. Important factors of

climate that affect vegetation growth include:
> Temperature
o Temperature influences plant growth. Most plants are unable to survive under 6°C.
This explains the lack of vegetation under places with polar climates, whereby
temperatures are usually sub-zero. Only plants such as moss and lichen are able to
adapt to the harsh conditions of polar climate.
o On the other hand, in places with temperatures consistently above 20°C, growth of
plants, especially trees - are abundant.
> Precipitation
o Plant growth is also highly influenced by the precipitation found in an area as it
affects the photosynthesis rate of the plant. Many forests are found in areas where
precipitation is high (1000mm and above per year) and grasslands are found in
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areas with moderate precipitation (200mm - 1000mm) and few plants can be found
in areas with little or no precipitation.

Key Characteristics of Specific Climate

Climate

Equatorial

Tropical Monsoon

Cool Temperate

Temperature:
High average annual

temperature

Small temperature range
- High humidity level
- Low latitude

Almost constant distribution
of temperature

Temperature:
High average annual

temperature
Temperature range is
dependent, ranging from

small to large.

Fluctuating temperature

Temperature:
Low average annual

temperature
Large temperature range

Seasonal distribution of
temperature

Precipitation:
High average annual

precipitation

Even distribution of rainfall
throughout the year
- High solar radiation
which results in high
relative humidity
- Water vapour —
Convection current —
Rainfall
- Convectional rain

Precipitation:
Moderate to High average

annual precipitation

Uneven distribution of rainfall
throughout the year

Distinct wet and dry seasons
- Convection currents

Precipitation:
Low average annual

precipitation

Relatively even distribution
of rainfall throughout the year
- Precipitation may
come in the form of
snow due to low
temperatures

Equatorial Climate:
Found:

Near the Equator
Characteristics:
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Temperature Distribution:
Constant distribution
Precipitation Distribution:
Constant distribution

Mean Annual Temperature:
>25°C

Total Annual Precipitation:
1500mm-2000mm

Tropical Monsoon Climate:

Found:

Within 23°S to 23°N (Tropic of cancer and tropic of capricorn)
Temperature Distribution:

Fluctuate

Precipitation Distribution:

Unevenly distributed /Seasonal (due to monsoons)

Mean Annual Temperature:

>25°C

Total Annual Precipitation:

Cool Temperate Climate:

Found:

Between 45°S/N and 45°S/N

Temperature Distribution:

Fluctuate

Precipitation Distribution:

Unevenly distributed /Seasonal (due to monsoons)
Mean Annual Temperature:

>25°C

Total Annual Precipitation:



Rainforests:

Tropical Equatorial Rainforest
Equatorial rainforests are found in areas with hot, wet climate, where there is high temperature and

high rainfall throughout the year. They can be found in the following regions:

- Amazon Basin of Brazil, South America

- Zaire/Congo Basin of Africa

- Central America

- South-east Asia

- Parts of western Peninsular India & Bangladesh

Characteristics
> Between 10°N and 10°S of the Equator
> About 27°C and 1500mm
> High biodiversity of flora and fauna
> Sparse undergrowth with dense emergence and canopy layers
> 5vertical layers

Structure of a Tropical Rainforest

Emergent Layer > Made up of tallest trees called scattered emergents.
> Growupto40-50m

Canopy Layer Crowns here form a continuous canopy.
Prevents sunlight from reaching the ground.
Trees are 20 - 30 metres tall

Presence of non-parasitic plants

YVYVYY

Y

Smaller trees with narrow crowns
Trees are 5 - 15 metres tall
presence of some lianas & epiphytes

Understorey Layer

vy

Shrub Layer > Consists of shrubs, ferns & small young trees

Y

Ground Layer Sparse vegetation due to lack of sunlight

Saprophytes [fungus etc.], small plants & ferns

Y




Tropical Mangrove Forest:

Mangroves are various types of trees up to medium height and shrubs that grow in saline coastal
sediment habitats with low wave action in the tropics and subtropics mainly between latitudes
25°N and 25°S.

Mangrove forests are found within the tropics, covering more than 240 000 sq km of coastal land in
the world.

Regions where mangrove forests are located (between 25°N and 25°S):
- Coastal districts of all insular South-east Asian countries, especially Indonesia
- Coastal districts of tropical Brazil, Venezuela and the Guianas
- Central America & the Caribbean islands. E.g. Mexico, Panama and Cuba
- Tropical African coastland, east and west Africa
- Northern Australia, southern India, Bangladesh and Sri Lanka

Mangroves grow in intertidal zones with salty, brackish water, where soil is muddy, waterlogged
and deficient in oxygen. They are halophytic trees, i.e. they are salt-loving plants. There are three
main communities:
Avicennia (coastal zone)

- Colonise mud banks that are usually exposed at neap tides
Sonneratia (middle/intertidal zone):

- Only come into contact with salt water when the tide comes
Bruguiera (inland zone)

- Has the least contact with salt water

- Leastsalt tolerant

Characteristics

Between 23.5°N and 23.5°S of the Equator

About 20 - 30 °C and 1000 - 2000 mm

4 main species of vegetation

Sparse undergrowth — consists of root structures and young mangrove plants
Dense cover of foliage at the crown forming a canopy

3 horizontal layers

YYVYVYYVYY

Temperate Coniferous Forests

Temperate coniferous forests are almost entirely found in the northern hemisphere. Regions
include North America, northern Canada Asia, extending from countries in Northwest Europe on
the Atlantic Ocean eastwards into Central Europe and into coastlands of Kamchatka bordering the
Pacific Ocean.

Characteristics
> Between 60°N and 70°S of the Equator
> Aslow as -40°C in winter and may be up to 21°C in summer
> 300 - 635 mm of precipitation



> Vegetation is of uniform in height

> Not dense with sparse undergrowth



Adaptations

Adaptations of Tropical Rainforest

Characteristics of Vegetation

Adaptation

Luxuriant Vegetation
- Great species diversity
- More than 100 species per hectare

Efficient rate of utilising solar energy in
photosynthesis by green plants

Hot and wet climate encourages rapid
growth

Evergreen
- Do not shed leaves at the same time
- Continuous plant growth
- Germination, flowering and fruiting
takes place throughout the year

High and regular rainfall, little seasonal
variation

Fruits and Flowers
- Sweet smelling fruits
- Colourful flowers

To attract insects and birds — aids in
pollination

Straight trunks
Wide, shallow crowns in canopy layer

Signs of competition for light, air, space
and nutrients to obtain maximum light

Leaf Litter
Large amount of litter

Hot, humid climate — leads to high rate of
decomposition

Hardwoods
E.g. meranti, keruing, balau, kapur, chengal

Leaves
Broad and green

Downward pointing drip-tips

Green — More chlorophyll to trap more
sunlight for higher rate of photosynthesis
Broad — More surface area for more
chlorophyll

To allow excess water to drip off

Bark
Smooth and thin

Weather is hot and humid — no need for
thick bark to protect the tree from the
cold/dry weather

Branches and Leaves
Found at top % of trees

To obtain maximum light for
photosynthesis
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Roots > Moisture from high rainfall and nutrients
Shallow found in topsoil

Roots > To support heavy weight of tall trees
Buttress roots found in larger trees

Different layers of the Mangrove
> (oastal Zone
> Middle Zone
> Inland Zone

Adaptations of Avicennia [Furthest from coast, found in the coastal zone]

i

Adaptations of Rhizophora [Middle zone]
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Adaptations of Bruguiera [More inland part of the mangrove/middle zone]
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Evaluating the importance of Mangrove through PPECS:
Physical
» Ecosystem
o Provides prey hiding spots
o Balances the food chain
> Protect coastline
o Slows down erosion from waves — roots from trees help to hold the soil together
> Water Quality
o As the tide recedes, mangrove roots trap some rubbish to allow cleaner seawater.
Economic
> Livelihood
o India fisheries by the mangroves — provide a source of income for the people
> Eco-tourism

o Places like Sungei Buloh are a boost to the economy. (tourism/income of people)

Adaptations for Cool Temperate Climate

Adaptations of Evergreen Conifers
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Deforestation :
Stands Taken By Various Stakeholders
Environmentalists :
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Against [-ve impact]
Physical:

R
0.0

Animals
> Deforestation destroys the habitats of many plant and animal species. Since trees act
as a form of shelter for them and is where some obtain their food, the loss of trees
threatens their survival, reducing the biodiversity of flora and fauna, which may
result in the extinction of certain species.
Nutrient Cycle:
> Deforestation can also disrupt the nutrient cycle as natural vegetation ensures the
availability of leaf litter which decomposes and decays to form humus, adding
nutrients to the soil. Hence with the absence of trees, the soil becomes infertile and
eventually derelict, permanently hostile to vegetation growth. Deforestation also
drives climate change.
Changing of Climate:
> Forest soils are moist, but without protection from sun-blocking tree cover, they
quickly dry out.
> Fewer trees also alter the microclimate of the forest since it leads to reduced
transpiration thus less cloud formations and less rainfall, causing droughts. Without
trees, many former forest lands can soon become barren deserts.
Floods:
> Cutting down of trees also results in higher risks of flooding as without roots to hold
the soil firmly together, soil erosion will be able to take place a lot more easily it will
be washed into the river. The deposited soil will make the river bed shallower,
causing water to overflow into the river banks.
Water Quality:
> There will also be changes in the quality of water as increased sediment levels in the
rivers results in a higher pH, adversely affecting the lives of marine life which can
only survive within an optimum range of pH.
> Also, the soil that is eroded and washed into rivers pollutes the rivers, hence
lowering the quality of water.
Global Warming:
> Trees also play a critical role in absorbing the greenhouse gas that fuels global
warming. Thus fewer trees mean larger amounts of greenhouse gases entering the
atmosphere - and increased speed and severity of global warming. Trees, which are
the main suppliers of the oxygen we breathe—are being chewed up at an
alarming rate.
Affects Ecosystem
> Getting rid of the forests will destroy ecosystem. Forests are the habitats to many
animals and food source for humans. If the trees are destroyed, the ecosystem will
be disrupted as a lot of species would go extinct.
Biodiversity:
> With the clearance of forests, there will be a loss of plants and biodiversity.
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> Secondary Forests - Less range of plants (indonesia grows teak for reforestation)-
biodiversity is compromised.

Mining or timber companies / Owners of plantations / loggers/cattle ranchers :

For [+ve impact and -ve impact]
Economic:

+ve

Social:

Many companies or industries which require labourers to clear the forests actually create
employment opportunities for these workers who likely have difficulty finding jobs due to
their low education.

For timber companies, employment is extended to the people who use raw lumber to make
wood byproducts such as wood furniture and pencils.

If deforestation would cease to exist many individuals would find themselves unemployed
and unemployment would then be a major issue. Tropical rainforests provide many natural
resources such as medicine, timber and clothing which are essential to many industries
such as timber companies.

However, although deforestation to clear land for cattle ranching or agriculture often
provides the local economy with new resources and land that lures investment dollars and
development, these gains are only short term and temporary: This is because rapid
deforestation often destroys the rainforest faster than it can replenish itself, thus much of
the supplies from rainforests which are essential to the sustainability of these industries
will be quickly depleted. For example, once timber disappears, the loggers move on, and the
soil also becomes less fertile, also |decreasing the productivity and profitability of the land
for agriculture.

As deforestation creates jobs, it allows workers to earn income to support and sustain
themselves and their family. It also raises living standards since with more money, they are
able to pay for more of their necessities such as food, clothes and even better housing or
educations.

Tribal people:
Against [-ve impact] (It is culturally and socially unjust for the tribal people)

Social:

R
0.0

The indigenous people have relied on the forest as their source of survival for many years.
They live in harmony with it and it is where they obtain all they need - their food, water,
medicine, materials needed to build shelter. Without all these, the tribal people lose their
homes and their survival are threatened.

Tribal groups are displaced and forced to change their resource base. In some cases, they
move into areas occupied by other groups, straining the region’s supplies. In other cases,
they were forced to relocate out of forests (and into the city), permanently altering their
lifestyles to something they are not accustomed to by converting to agriculture or cash
employment. (affects quality of life and happiness of the people)
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> These tribal people are unable to adapt to the busy lifestyle in the city, which is
completely different as compared to the more relaxed way of life in the forests.
+« Rarely are the rights of these indigenous people to the lands they occupy recognised by the
authorities. Furthermore, they intimate knowledge regarding the area’s natural resources
and how to manage them are nearly always ignored.
Cultural:
% The displacement from their homes often cause the tribal people to disSpéerséland their
unique cultures to be lost.
With more and more tribes getting dispersed, native speakers/tribal people are constantly
decreasing — loss of heritage of the tribes
Since the destruction of forests threaten their way of life, this also affects their traditional or
even religious practices — affects their culture and traditions

This results in a dilution'of the identity of the tribal people

R
L4

R
L4

R
L4

Government:
(for)

R
L4

The government prioritises the [development of the country, and not the environmental
aspect. Conserving the forests is not one of the government’s main priorities.
Deforestation helps to clear land, and the cleared land can be used to further develop the
country
> E.g. Land can be used to build infrastructure, which will help to increase the
standard of living of the country

> Land can also be used to build homes for the people.
m To build homes, materials, like wood etc, are also needed
Deforestation also helps to increase the revenue of the country, which can be used by the
government to implement new changes to aid in the development of the country
> Deforestation provides people with jobs — when people have an income, they have
to pay tax — money can go to the government for the development of the country
> Since an abundance of resources (vast forests) are present, these resources should
be taken advantage of to help benefit the country

R
L4

R
L4

Consumers (e.g. cattle ranchin
e Consumers prioritise their own economic benefits, instead of the environmental impacts
etc.
e Deforestation provides these consumers with a job
o E.g.clears land for cattle ranching

« From their point of view, deforestation s needed for their various industries to prosper —
o [DCs'domothavemoney/resources to produce recycled paper/materials, the money spent

is more even though the price of the items are the same. EDCSlook'atincreasing profit and
so turn to the most Eosteffectiveway. Deforestation offers a high profit and low losses way

of getting resources.
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Farmers:
o Farmers prioritise their own economic benefits. For these farmers, who are usually very
poor, farming is their sole source of income — in order to profit, need more harvests
e To cultivate more crops and raise more livestock to sell for more profits, more land is
needed.
o Deforestation helps to make space for their farm to develop and for them to grow
more crops and raise more livestock
o The slash and burn technique is cheap and fast
m Makes soil more fertile — improves plant growth
m (lears land very fast — reduces the hassle of manually clearing forests
m HOWEVER, the fires from slash-and-burn may sometimes get out of control
due to the dry and hot weather conditions that encourage the spreading of
forest fires
e Brazil resettled their farmers to the Amazon to plant their crops even with the trees.
However, the rainforest plants took up all the nutrients and the soil could not sustain the
crops. Thus, deforestation was carried out.

Deforestation
Refers to a massive clearing of trees in one area.

Describing trend in Deforestation
e In maps, it is good to split it into northern and southern hemisphere.

e Generally, the countries in the Northern hemisphere have a net gain in forest areas.

Describing the rate of Deforestation
e Take note of the intervals between the years/marks (E.g. one shows 2000, 2005, 2020)

Forests as a Resource [Functions of a Rainforest]

Maintain Water Supply
> Quantity of Water
m For example, Singapore’s Central Water Catchment Reserve consists of 4

water catchment areas surrounded by tropical rainforests.
o Transpiration and Groundwater
m More water may be lost via surface runoff or overland flow.
m Less water is stored as groundwater because of the lowered infiltration rate.
> Quality of Water
o Vegetation supports natural processes that filter the water.
m Interception would lead to less overland flow which traps less soil particles
and eventually lead to cleaner water.
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m Traps impurities in pore spaces — Helps attain clear water that is relatively
free of other substances.

The forest acts as a carbon sink and provides oxygen.
> Photosynthesis
o Remove carbon dioxide (greenhouse gas) from the atmosphere.
o Prevents global temperature from rising and regulates temperature of the Earth

> Roots hold the soil together, prevent nutrients from being lost through soil erosion.
> Decomposing vegetation (leaf litter) replenishes the nutrients used up in the soil.

> Supports a large number of flora and fauna

I v

> The forests are a home to BOOEMIGHIPESPIE worldwide.

> Forests are used for leisure and recreational purposes (hiking).

> Eco-tourism
o Provides jobs [tour guides]
o Forests attract people from all over the world to visit the country to explore the
forests
o This helps to increase the revenue of country through tourism
> Profitable commodities derived from the plants
o Global timber trade can clock up to $332 billion per year.
o Indonesia obtained $8 billion from timber sales in 2002.

Source of Raw Materials
> Food
> Medicine
> Building Materials
o Renewable resource [but trees take up to 40 years to mature]
> Fuelwood and Charcoal [Especially for LDCs]

Deforestation Statistics and General Trends
> Up to 129 million hectares of forest, equivalent to the size of South Africa, have been lost
since 1990.
> Forest areas have decreased since 1990, but the rate of net forest loss has been cut by 50%.
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Causes of Deforestation

What causes deforestation? Who is behind deforestation?

The forest is constantly being exploited for material uses. Population pressure causes government
to have a need to take action. The population is constantly on the rise (especially in less developed
countries with high birth rate and low death rate). It has to be ensured by the government that
everyone is provided with a basic standard of living.

Agricultural Conversion
> Slash and Burn Method

o Small farmers who are after profit practice subsistence farming of cash crops.

m  Cash crops (cocoa, rubber, oil palm) farming means that the farmer is only
paid for the amount of crops he is able to provide to the suppliers.

m Farmers want to expand their farm, and living near forests mean that cutting
down trees would be the most effective way to acquire more land for more
crops.

> Compaction
o Agricultural vehicles and cattles constantly go over the land, compacts the air
particles between the soil and makes it non-porous.
o Thin platy soil structure is observed and land is no longer suitable for growing crops
as it impedes infiltration.

Urbanisation
> Rural-urban migration because people from rural areas want to earn more money.
o Ultimately leads to the expansion of the city area.
o City expansion leads to more deforestation because they need more space for
development of infrastructures etc.
Transport Network
> Sectoral development
o People tend to want to be more connected to urbanised areas.
o Transport networks are able to increase accessibility into the city. Thus, land is
cleared to make way for the construction of transport networks.

CITY

Growth of Industries
> Emerging industries [Logging, Mining etc.]
> It provides jobs for people, LDCs are lacking in job opportunities.
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o Growing population but yet having little jobs available.
o These jobs provide income, so they have no choice but to do it anyway.

RESOURCE CURSE
> Less developed countries tend to have the materials, but the well developed countries have
money.
> Developed countries are superior compared to the less developed countries as they have
control to a certain extent over the economy of less developed countries. Thus, in certain
situation the less developed countries are exploited.
o Nigeria Shell Oil Spill

The blame does not solely lie with the less developed countries! Consumers are also responsible.
> Consumer - Producer Relationship
o Private companies from India and China import the forest risk commodities (timber,

herbs, palm oil, paper etc) to other consumers.
m  Without demand for forest risk commodities from these companies, there
will not be such a huge push for deforestation
> Politics affecting Deforestation
o Relaxed environmental laws
m  Some companies make use of the loopholes within the law to carry out
logging and deforestation.
o Poorly enforced laws
m Lack of manpower to prevent deforestation.
e Few rangers employed to patrol the entire forest. Loggers take
advantage of this and chop the trees.
e Corruption and bribery within higher up officials
> Not all deforestation is intentional.
o Climate change which is leading to higher temperatures and starting accidental
wildfires.
Effects of Deforestation
Loss of Biodiversity
> Food chain is greatly disrupted.
> The ecosystem is closely related so with the extinction of just one species other flora and
fauna may be affected.
> Sometimes, action taken may be too late. For example, they only claim that “Species X” is
endangered when it has 50 left, and the 50 eventually becomes extinct because the
protection help was rendered too late.

Enhanced Greenhouse Effect
> Forests are a carbon sink. With less trees, there will be changes in the carbon cycle and less
carbon dioxide is removed from the Earth through sequestration.
o This carbon dioxide is a greenhouse gas, which means that it traps heat efficiently
and may result in global warming.
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Other Environmental Changes
> Quantity of Water
o Less transpiration from less trees— Less precipitation
> Quality of Water
o Increased sediment levels in the rivers results in a higher pH
m Adversely affecting the lives of marine life which can only survive within an
optimum range of pH.

m Particles get washed into river more frequently because roots are not
holding the soil together
m Also, the soil that is eroded and washed into rivers pollutes the rivers, hence
lowering the quality of water.
> Nutrient Cycle
o Leaf Litter and Soil Leaching
m Less vegetation is present to vanish the leaf litter.
m Soil Leaching - Nutrients in the soil are washed down because of the
precipitation.
> Indigenous People
o Forced to vacate their homes
o Tribes start to disperse or break into smaller tribes.
o The people will have to adapt to a new way of living and unique culture is lost.

Natural Hazards
> Landslides
o Less trees — less roots to hold the soil together — soil becomes looser — topsoil
becomes weaker and more likely to give way
> Floods
o Lesstrees — less roots to absorb water from soil
> Haze
o Slash-and-burn — burning of trees will produce haze — affects air quality (physical)
o With poor air quality, the comfort of people will also be affected. People may also
suffer from respiratory problems, and this affects the health of people. (social)

Political Ties Strained
> Countries who are affected by the haze that is caused by slash-and-burn may get upset with
the country which started the slash-and-burn — strains political relationships between the
2 countries, especially with the other country is unwilling to take action to improve the haze
condition.

Is Deforestation Necessarily Evil?

Deforestation provides more land for agriculture, housing and the raising of animals, and it
provides pulp for paper. Additionally, deforestation creates grazing land for cattle, room for
commercial, residential and industrial development and lumber for furniture and construction.
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While not sustainable or good for the environment, slash and burn agriculture (the razing of forests
with fire for farming) creates land free from weeds, and the ash provides nutrients for crops.
> Roads
o More trade and new transport networks to bridge gap between rural and urbanised
areas.
> Agricultural Land
o Meet demands for food

However, negative impacts of deforestation outweigh the benefits.



